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Бу услубий курсатмада растрли ва векторли компьютер графикасининг энг куп таркалган 

Adobe Photoshop ва Corel Draw дастурлари билан танишиб чикилган, Ушбу дастурларнинг  бош 

менюси булимлари, асбоблар панели, расм чизиш, матн яратиш ва турли тахрирлаш  ишларини 

бажариш хакида   маълумотлар берилган. 

  «Компьютер графикаси» фани турли техник таълим йуналишлари буйича кадрларни 

тайерлашда фундаментал ахамиятга эга булган мустакил фандир. 

   Бакалаврлар ушбу мавзуларни узлаштириш натижасида  уз мутахассисликларида замонавий 

компьютер технологияларидан  тулаконли фойдаланишга эга булади.        

 Ушбу услубий курсатма «Компьютер графикаси» фанидан амалий ишларини утказишда 
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тавсия этилади.  
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1-Амалий машгулот 
Аdobe Photoshop 7.0 Программаси билан танишув 

 

Ишнинг максади:Аdobe Photoshop 7.0 прогрпммасининг имкониятлари урганиш 

Программа функциялари билан танишув 

Вазифа: 

Асосий мулокот ойналари Билан танишув 

Асосий элементлар ва буйруклар Билан ишлаш 

 

Назарий кисим. 

Программани ишга тушириш: Windows 95, 98, ME, 2000, ХР или NT операцион системасида ке Start 

(Пуск) пугмасига босинг панели задач булимида жойлашган Programs (Программы) булимига киринг 

сунгра Adobe, Photoshop 7.0 ичидаги  Adobe Photoshop 7.0 элементи учтига сичконча Билан босинг 

. Adobe Photoshop 7 программаси мавсум программалар орасида   суперхит прдуктга айланди. Уни утига 

бу программанинг хар бир сони  узида яниги элементларни мужассамлантирган. Бу узгаришлар 

Photoshop 07 версиясида хам кузатилади. Ишлаб чикарувчилар бу программадаги бир катор 

камчиликларни бартираф килишди , буларга Windows и Mac OS X. Кисмида , Photoshop 7 нихоят 

виртуал хотира системасини ишлаишни урганди , натижада Оператив хотиранинг бир канча кисми 

тежаб колинди. Бу тежмкорлик ката хажимга эга булган  тасвирлар Билан ишлаганда сезилади. 

Шунингдек операцион системани осилиб кошиши камайди. Хозирда  Photoshop бошка бир канча 

датурлар Билан бир вактта яхши ишлаши мумкун. 

 

Рас 1.1. Photoshop 7 экран куриниши. 

Расимда Photoshop программасида ишлаш пайти курсатилган. (1) тугмаси босиб бошкарув менюси 

ишга туширилади. У узида куйдаги буйруклар (команда)ларни мужассамлаштирган: Restore (Кайта 

тиклаш(Восстановить)), Move (Силжитиш(Переместить)), Size (Улчами(Размер)), Minimize (Пастга 

тушириш(Свернуть)), Maximize (Очиш(Развернуть)) ва Close (Ёпмш(Закрыть)). (7) тугмаси ѐрдамида 

хужжатни бошкариш менюси ишга туширилади. Асосий менюда куйдагича командалар мавжуд: Restore 

(Восстановить), Move (Переместить), Size (Размер), Minimize (Свернуть), Maximize (Развернуть), Close 

(Закрыть) ва Next (Кэйнги(Следующий)).  

 



      Photoshop ва ImageReady программаларига тасвирни тез куриб чикиш  модули киритилган. Олдин 

эса бу ишни амалга ошириш учун ташки программа(утилит)лар ишлатиларди масалан ACDSee ѐки 

ThumbsPlus. (PDA) чунтак компютерлари учун расимни импорти ва экспорти WBMP форматли 

фильтрлари киритилган.  Компютернинг ишлаш чегараси доирасида автоматик тарзда расмнинг 

сифатини бузмаган холда мослашув(оптимизация)ни бажаради. 

Photoshop 7 программасига гурух(групповой) булиб ишлаш учун кушимча имкониятлар киритилди. Бу бир 

компютерда турли фойдаланучилар томинидан Adobe программасида ишлаш имкониятини берадиган 

AfterCast кенгайткич кушилди. Агар бир фойдаланувчи тасвирга узгартириш киритса бир вактни узида 

хама фойдаланувчилар кузата олади. Аммо AfterCast созлаш(настройка)ни факат администратор бошкара 

олади, лекин бу уз уй компютерларида Photoshop программасида ишловчи фойдаланувчилар бу муаммога 

дуч келмайдилар. Биз юкорида факатгина Photoshop 7ни асосий имкониятларини санаб чикдик. 

Асбоблар панели(панель инструментов) 

        Экранда турган программа асбобларини ишга тушириш учун сичконча Билан униустига босинг ва 

экранда куриниѐтган пиктограммани устига босинг. Бир хил пиктограммалар ѐнида кичик 

курсаткич(стрелочка)лар мавжуд. Агар уни устига босилса тасвирга тугри келувчи ойна(всплывающая 

палитра)лар курсатилади, у ердан сиз керакли асбобларни танлашингиз мумкин. Хаар бир асбоб учун 

узининг улчам(параметр)лари экран теппасида жойлашган опциялар панелида мавжуддир (масалан, 

режим смешивания, значение непрозрачности) . 

 

 

Рис. 1.2. асбоблар панелида пайдо булувчи маслахат(подсказка) ойнаси 

Эслатма :Edit > Preferences > Display& Cursors (Правка > Установки > Отображение&курсоры) 

ойнасида курсор ва асбоблар  пиктограммалари куринишларини созлаш мумкун.  

Опциялар панели (Панель опций)  

Опциялар панели хар бир асбобнинг параметорларини созлаш учун ишларилади(масалан, 

шаффофлик даражаси ѐки тасвирни аралаштириш рижимини) -  1.3 расм . Опциялар панелининг унг 

томонида махсус рангларни сакловчи булим мавжуддир. Параметроларни курсатилиши кайси расмни 

танланганига боглик(1.3-1.8 расм). Фойдаланувчи томонидан киритилган тасвир куриниши  бошка 

узгартиришлар киритилгунча сакланади. Палитра ва опциялар панелини хам экранни исталган жойга 

силжитиш мумкин.  

 

Рис. 1.3. Brush асбоби учун опциялар панели   

 

Рис. 1.4. Rectangular Marquee асбоби учун опциялар панели   

 

 

Рис. 1.5. Gradient асбоби учун опциялар панели    



 

Рис. 1.6. Реп асбоби учун опциялар панели    

 

Рис. 1.7. Rectangle асбоби учун опциялар панели    

 

Рис. 1.8. Туре асбоби учун опциялар панели    

Эслатма:  Edit > Preferences > Display& Cursors (Правка > Установки > Отображение&курсоры) 

ойнасида курсор ва асбоблар панелидаги асбоб пиктограммасини танлашингиз мумкун. 

  НаОпциялар панелининг унг томонида актив асбоб пиктограммаси курсатилган. Агар 

пиктограмма ѐнидаги  стрелка устига босилса , куринмай турган меню очилади, унда бошка 

керакли булган асбобни танлаш мумкун. Бу жадвалга узгартиришлар киритиш мумкун яни кам 

ишлатилаѐтган асбобларни олиб ташлаб урнига керакли булган асбобларни жойлаш мумкун. 

Хаар бир  опциялар панелига киритилган узгартиришлар автоматик тарзда сакланиб колинади. 

Тугмаларни кайта тиклаш ва жойлаштириш учун пайдо булувчи панелдан амалга оширилади. 

Пайдо булувчи ѐрдамчи маслахатлар(всплывающие подсказки)  

Исталган пиктограмма устига сичкончани босмасдан олиб боринг шунда сиз ишлатмокси булган 

асбобнинг номи ва уни клавиатура оркали ишга туширадиган тугмачалар курсатилади. Шу Билан бир 

каторда ишлатилаѐтган опциялар ойнаси ва унинг вазифаси хакида кискача малумот олиш мумкин (1.9 

расм). Edit > Preferences > General (Правка > Установки > Общие) ойнасидаги ѐрдамчи маслахтлар 

ойнасини ишлатиш учун Show Tool Tips ойнаси устига байрокчани урнатинг (Показывать всплывающие 

подсказки)   

 

Рис. 1.9. Опциялар панелидаги ѐрдамчи маслахатлар 

Программанинг барча командалари учун Асосий меню (Главное меню) мавжуддир: 

 

Рис. 1.10. Асосий меню 

File (Файл) менюси куйдаги холатларда ишлатилади: яратиш(создать), очиш(открыть), 

жойлаштириш(разместить), ѐпиш(закрыть), саклаш(сохранить), сканирлаш(отсканировать), импорт ва 

экспорт, когозга чикариш(напечатать изображение), Файлни тармок оркали узатиш(передать файл по 

сети), бир нечта опцияларни автоматлаштириш учун ва албатта Photoshop дастуридан чикиш учун. 

Edit (Правка) менюсида, тасвирни редактирлаш яни созлаш учун командалар: 

нусхалаш(копирования), узгартириш(трансформации), жойлаштириш ва тасвир рангларини тусини ва 

муйкалам калинлиги ва турини танлаш мумкин. 



Mode (Режим) менюоси оркали Image (Изображение) менюси, тасвир саккиз турдаги  тасвир 

уринишларини танлаш мумкин. 

Layer (Слой) менюсида жойлашган командалар, бир неча катламлардан жойлашган тасвир устидаги 

амаллар яни: катламлар аро богланишни катламлар кетма кетлигини ва катламларни умумий катламга 

бирлаштириш имкониятини беради. 

Select (Выделить) менюсида жойлашган командалар – керакли катламларни танлашда ишлатилади. 

Filter (Фильтр) менюси узида тасвирларни бирлаштириш ва умумий холга келтириш учун керакли 

булган филтири мавжуддир. 

View (Вид)менюсидаги командалар, экрандаги тасвирни куринишларини назорат килади. 

Window (Окно) менюси командалари, зкрандаги бошка тасвирларни акс эттиради ва улардан 

керакли булган пайтда фойдаланиш имконини беради. 

Help (Помощь) менюсидаги командалар фойдаланувчи учун керакли булган маслахатлар оркали кумак 

ва хозирда бажариш мумкун булган имкониятлар билан таништиради хамда Photoshop мухторий сайтига 

мурожат килш имкониятини беради.  

Исталган тасвирни хохлаган пайтда узгартиришлар киритиш имконини ва 12 турдаги Photoshop 

кенгайтма(формат)ларида саклаш имконини беради. Аммо одатта асосий куйдаги Photoshop форматлари 

ишлатилад: TIFF, GIF, JPEG, EPS. 

Photoshop программасида купгина операциялар асасан политралар оркали бажарилади. Экранда куп 

жой эгаламаслиги учун политралар узаро гурухларга бириктирилган: Navigator/Info 

(Бошкарув/Информация), Color/Swatches/ Styles (Ранг/Намуна/Услублар), History/Actions/Tool Presets 

(Тарихи/Харакатлар/Асбоблар танлаш), Layers/Channels/Paths (Катламлар/Каналлар/Контурлар) и 

Character/Paragraph (Шрифт/Абзац). 

Палитралар (палитры) 

Photoshop программасида куп операциялар палитралар оркали бажарилади уларни узаро 

аралаштириш хам мумкун. Исталган палитрани очиш учун эса Window (Окно) меню командасидан 

амалга оширилади. Белгиланган палитра бошка  шу гкрухга кирувчи политралардан энг юкрида 

автоматик таризда жойлашади.Photoshop прогрпммасидан чикиш: Windows  Операцион дастурида бу 

дастур ойнасини ѐпиш учун File > Exit (Файл > Выход)менюсидан курсатилган командани танланг ѐки 

(Ctrl+Q) тугмалар комбинациясини босинг 

Назорат саволлари: 

 

1. Аdobe Photoshop 7.0 дастури кандай ишга туширилади? 

2. Аdobe Photoshop 7.0 дастурининг асосий менюст нималардан ташкил топган? 

3. Опциялар панели нима учун ишлатилади? 

4. Палитра операциялари оркали нима бажариш мумкун ? 

 

2- Амалий машгулот 
Тасвир яратиш(Рисование) 

Ишнинг вазифаси: Сканер оркали олинган тасвирни узгартириш ва асбоблар панели оркали 

тасвирни яратиш . 

 

Вазифа: 

1. Brush асбоблири билан танишиш. 

2. Brush асбоби ѐрдамида тасвирга шрихлар ва узгартиришлар киритиш.  

 

Назарий кисим. 



 

Brush асбоби  

1. Керак булган катламни танланг ва асбобнинг имкониятини чеклаш учун ундаги керакли кисимни 

белгиланг.  

2. Brush асбоби пиктограмма устига сичконча ѐки клавивтура ѐрдамида босинг.  

3. Асосий рангни танланг . 

4. Опциялар панелида Brush (муйкалам) муйкалами услубини танлаш учун стрелкаси устига босинг( 

2.1 расм). Хаар бир пиктограмма устидаги ракамлар муйкаламни калинлигини пикселларда курсатади. 

Агар сиз исталган муйкалам устига олиб борсангиз шу муйкаламнинг калинлиги ва тури хакида малумот 

чикади. (Бошка турдаги муйкаламларни танлаш учун 12чи кисмда келтирилиб утилган «Муйкаламлар 

кутубхонасини юклаш(Загрузка библиотеки кистей)»). Муйкалам панелини ѐпиш учун панелдан 

ташкаридаги экраннинг исталган жойга босинг ва автоматик таризда панел ѐпилпди. Mode 

(Аралаштириш рижими(Режим смешивания))булимини танланг, хамда Opacity 

(Шафофсизлик(Непрозрачность)) булимини фойз курсакичида Brush (Кисть) асбоби учун танланг ( 

2.2.расм) каранг. Агар курсатилган кисим параметри 100% ни ташкил килса муйкалам штрихи пастки 

пикселларни мутлок коплайди. 

 

Рис. 2.1. Муйкалам шаклини танлаш панели  

Эслатма:Факатгина шфоф булмаган катламларни рангини узгартириш учун Layers (Катлам(Слои)) 

палитрасидаги Lock transparent pixels (Зафиксировать прозрачные точки) устига бийрокчани урнатинг. 

  

Рис. 2.2. Opacity параметирини белгилаш  

Photoshop 7.0  программаси ѐрдамида сиз бирканча стандарт муйкаламлар ѐки узингиз улчамлари ва 

куринишини киритган холда жуда кизикарли рассомчилик ишларини амалга оширишингиз мумкин(2.3 

расм).  

Расмлар билан ишлаш учун янги процессор ута кизикарли булган расмларни яратиш имконини 

беради. Photoshop 7.0 программасида стандарт ва аввалдан фойдаланувчи киритган расмларни нусхалаб 

унга сайкал бериш  шу билан бирга тасвирга хул ва курук муйкалам усулларида безак бериш мумкин. 

Муйкалам пакетига барг ва утларни тасвирини яратадиган махсус эффект муйкаламлари китилди. 

Махсус оригинал тасвирларни яратиш учун сканердан утказилган расм ва текстларни орка фон сифатида 

шаффоф куринишда тасвирга киритиш мумкин.  Photoshop 07 программаси процессори факат янги 

тасвир яратиш имкониятлар билан чекланиб колмай балки, бошкарувнинг содалашганлиги эътиборга 

олинган. 



 

Рис. 2.3. Хаар хил турдаг муйкаламлар билан  Brush асбоби билаш чизилган чизиклар  

Мавжуд булган муйкаламни узгартириш(Изменение существующей кисти)  

Photoshop программасига кушимча сифатида муйкаламлар омбори хам берилади ва сиз у ердан 

исталган муйкаламни танлаб уни хошингизга кура узгартириш (модификация) килишингиз мумкин.  

1.Опциялар панелидан Brushes (Муйкалам(Кисть)) тугмасига босинг ундаги менюдан Brush Tip 

Shape - см.  2.4 расм булимини танланг.   

2.Diameter (Диаметр) эфектни керакли жойгача чузинг ѐки муйкалам диаметирини киритинг    (1 дан 

999 пикселгача).  

3.Муйкалам изи шаффофсизлигини белгиловчи Hardness (Каттиклик(Жесткость)) койфицентини 

танланг ѐки уни хам фойз микдорда киритинг (0-100%гача).  

4.Муйкалам колдирган излари узоклигини Spacing (Интервал) оркали бажарилади (0-999%)  фойз 

микборини оширилган сари штрихлар орасидаги масофа каталашб боради. Шунингдек бу вазифани 

курсор ѐки муйкалам хам бажариши мумкун бунинг учун  Spacing (Интервал) тугмасидан байрокни 

олиб ташлашни узи кифоя канчалик курсорни тез харакатлантисангиз шунча оралик катталашади ва 

акси (12 булимни кар, «Выбор опций пера» кисми).  

Эслатма :Купгина стандарт урнатилган муйкаламлар учун аосан Spacing и Diameter булимларини 

узгартириш мумкин.  

5.Муйкалам изини доира ѐки бошка эллипс куринишларини 

белгилаш учун Angle (Бурчак(Угол)) булимидан ( -180° дан +180° 

гача) кийматларни курсатинг ѐки экраннинг чап тарафидаги 

расмдаги стрелкани хохишга кура жойлаштиринг.  

6. Муйкаламни сочма ѐки тиниклаштириш учун Roundness 

(Округлость) (0-100%) параметрларини Беринг фоиз микдори 

ортгани сари нукта изи тиниклашади.  

Янги муйкаламни яратиш(Создание новой кисти)  

1.Brush (муйкалам) менюсидан New Brush (Янги 

муйкалам) буйругини танланг.  

2.Мавжуд муйкаламни узгартириш«Изменение 

существующей кисти»  булимидан 2 дан 8 гача булган 



буйрукларни танланг. Create New Brush (Янги муйкаламни яратиш) булимига бир марта 

босинг ва керакли улчамларни Беринг агар сиз Ушбу тайѐр муйкаламни саклаб колмокчи 

булсангиз уни номини киритинг ва ОК тугмасини босинг. (Аммо бу Янги муйкалам хеч кайси 

библиотекага киритилмайди.)  Сакланган муйкалам пиктограммаси танлаш панелида охирида 

жойлашади. Сакланган муйкаламни библиотекада саклаш 21 боб, «Янги библиотеада 

муйкаламни саклаш» булимида курсатилган.  

 

       Рис. 2.4. Муйкалам улчамлари ойнаси  

Тасвирдан иборат булган муйкаламни яратиш(Создание кисти на основе изображения)  

1.Rectangular Marquee (Прямоугольная область) асбобини активлаштириш учун клавиатурадан М 

тугмасини ѐки  Shift+M тугмаларини босинг.  

2.Ок фонда берилган фигуралар Билан тасвирни чегарасини белгиланг(максимум 1000x1000 

пикселгача). 

3.Edit > Define Brush (Правка > Муйкаламни аниклаш) командасини танланг.  

4.Юкрида айтиб утилгандек Ушбу Янги муйкалам нимини киритинг ва ОК тугмасини босинг. Бу 

муйкаламдан Brush (мукалам) менюси Билан ишлаѐтганда фойдаланиш мумкин. Пайдо булувчи 

муйкалам улчамларини Spacing (Интервал) тугмасидан штрихлар орасидаги масофани 

аниклашниринг(1-999%).  

5.Белгиланган зонани кайтиб уз холига келтириш учун Ctrl+D тугмаларини биргаликда босинг.  

Муйкаламни учириш(Удаление кисти)  

1.Мукалам танлаш панелини очинг.  

2.Биринчи усул: Alt тугмасини босиб туриб учирмокчи булган муйкаламни белгиланг. Бу харакатни 

оркага кайтариш(отменить) мумкин эмас.  

Иккинчи усул: Кераксиз булган мукаламни курсатинг ва Delete Brush (Муйкаламни учуриш) 

буйругини танланг 2.5 расмга каранг.  

 

Рис.2.5. Муйкаламни учириш 

 Background Eraser ва  Magic Eraser асбобларини ишлатилиши 

Magic Eraser (Музизавий учиргич) менюси сичконча тугмаси Билан учириш имконини беради. У сиз 

курсатган ранга якин булган пикелларни учиради. Буни аксини эса Paint Bucket (Ведро с краской) 

асбоби бажаради. Агар сиз шаффофсизликни 100% дан пастрогини танлаган булсангиз унда  Magic 

Eraser асбоби оркали керакли жойлани шаффоф куринишга келтиришингиз мумкин. 

 

 

 

Рис.2.6.   Magic Eraser асбобининг опциялар панели 



Background Eraser (фон учун учиргиш) асабоби бу фондаги кераксиз жойларни учиради ѐки 

керакли ранга буяйди. Бу асбобнинг устунлиги шундаки у Билан аралаш фонларни якдил холатга ва 

учирилаѐтган зонани ѐки чегараларни хамоханглигини назорат килади. 

 
 

Рис.2.7. Background Eraser асбобининг опциялар панели  

Катламларни зоналари уйгунлиги(Стирание части слоя)  

1.Хохлаган катламни танланг. Eraser (учиргич) асбоди ѐрдамида катламдаги кераксиз жойларни 

учирмокчи булсангиз унда Lock transparent pixels (Зафиксировать прозрачные точки) булимига 

байрокчани урнатинг шунда учирилаѐтган Катлам ундан олдинги катламни фонига эга булади. Агар 

Lock transparent pixels (Зафиксировать прозрачные точки) булимидаги байрокча олиб ташланса унда 

учирилган кисим шаффоф холатга утади.  

2.Eraser (учиргич) асбобини Е тугмаси ѐки Shift+E тугмаларини бирга босиб уни ишга туширинг.  

3.Опциялар панелидан Brush (Кисть) булимига киринг ва керакли булган муйкаламни танланг.  

Mode (Режим) булимидан керакли режимни танланг: у ерда  Brush (муйкалам), Pencil (калам) ѐки  

Block (Блок) ларни танланг 2.8 расмга  каранг. Хул буѐкни акслантирувчи  Brush (Кисть) браш 

эффектини танлагн. Opacity (Шаффофсизлик) параметрларини  курсатинг.  

 

Рис.2.8.   Eraser асбобининг опциялар панели 

Автоматик учириш режими(Режим автоматического стирания)  

Auto Erase (Автоластик) уз узидан автоматик таризда ишлашга мулжалангандир агар сиз униг уз 

хохишингизга кура ишлатмочи булсангиз куйдагиларни бажаришингиз шарт.  

1.Керакли булган фон рангини танланг. Бунда Eyedropper (Пипетка) асбобидан ранг ташлашда 

фойдаланишингиз мумкин.  

2.Керакли булган катламни белгиланг.  

3.Pencil (Карандаш) асбобини активлаштиринг, бунинг учун В тугмаси ѐки Shift+B тугмаларини 

биргаликда босинг.  

4.Опциялар панелидан  Auto Erase (Автоластик) асбоби устига байрокни урнатинг.  

5.Тасвтрга штрихларни чизинг. Асосий пикселдан бошлаб керакли худудгача курсорни тортиб 

боринг ѐки бошка синга макул булган пикселдан бошлашингиз мумкин.  

 

Синов саволлари. 

 

1.  Brush асбоби имкониятларини санаб беринг. 

2.  Background Eraser буйруги нима учун ишлатилади? 

 

 



 

3-амалий машгулот 
Матнлар билан ишлаш(Работа с текстом). 

Ишниннг максади: Программа функциялари билан танишиш. 

                                              Вазифа: 

 

1.Матин яратиш ва уни тахрирлаш. 

2.Яратилган матинга эффектларни кулаш. 

 

Назарий кисм. 

Photoshop 07 программасида матин вектор куринишига эга. Программада текст узинигнг аник чегара 

ва контурларига эга чунки программа матинларни ишлатаѐтгарда вектор контурини куллайди. Шу Билан 

бир каторда матин хам расм сифатларини узида мужассамлаштирган. Бу матин принтердан 

чикарилишига карамай у PDF ѐки EPS форматларида сакланаши ва уз тинниклигини саклаб колади.  

Photoshop программа факатгина текстларни киритибгина эмас балки уларни ѐзилаѐтган вактида ва 

ѐзилгандан сунг хам уларни тусини рангини куринишити хамда йуналишини узгартириш мумкин.  

Матинни Яратиш(Создание текста)  

Photoshop программасида текст ѐзиш учун Туре (Текст) буйруги танланади ва автоматик тарзда 

керакли жойда уз махсус катламига эга булган фонда ѐзила бошлайди. Исталган пайтда унинг 

куринишини узгартириш мумкун масалан:  шрифт, услуб, кегль, ранг, кернинг
 
, трекинг

 
, ораликдаги 

интервал, тугирлаш, тексн чизикларини хажмини. Бундан ташкари бир текстни узига бир канча 

атрибутларни киритиш маумкин(3.1 расм). 

Шу Билан бир каторда текстнинг маносини механик тарзда узгартириш унга хар хил эффектлар 

куллаш ва у жойлашган Катлам устида бир канча имкониятларни куллаш мумкин. Текст катлами устида 

кандай аммалар куллаш мумкин? Унга филтирни куллаш, текстдан тозалаш ва расларга тулдириш 

мумкин. Бу аммаларни бажариш учун энг аввало текст катламини Layer > Rasterize > Туре (Слой > 

Преобразовать в растровый формат > Текст) асбоби оркали белгилаб ундаги командани танлаш керак. 

3.2 расмда энг аввало уни активлашнириб сунгра филтр ва турли катлам эффэктлари куланилган.  

Эслатма:Bitmap, Indexed Color и Multichannel, рижимида яратилган текст уз катламига эга 

булмайди ва тугридан тугри экран фонига тушади ва уни тахрирлам имконияти йуколади.  

Турли хилдаги текстлар(тахрирланадиган ва тахрирланмайдиган) куринишлари Туре (Текст) , Layer 

(катлам), Character (Шрифт), Paragraph (Абзац) асбоблари ва опциялар панели оркали яратилади.  

 

Рис. 3.3. Туре асбобининг опциялар панели 

Тахрирланадиган матин катламини яратиш(Создание редактируемого текстового слоя)  

1.Энг аввало Туре (Текст) асбобини Т тугмасини босиш билан активлаштиринг.  

2.Сунгара текстни жойлаштириш керак булган экрандаги кисимни улчамларини сичкоча оркали 

белгиланг(сузлар ва текстлар бир бирига тукнашиб кетмаслиги керак). Яхшиси хар бир сузни алохида 

катламга ѐзинг шунда уларни бир биридан мустакил равишда силжитиш имкони кулга киритасиз.  

3.Опциялар панелида куйдаги ишларни бажаринг:  

o Туре тугмасига босинг ва текстнинг йуналишини курсатинг(горизонтал, вертикал);  

o Ширифтлар оиласини, услубини кеглни танланг;  

o Шунингдек Anti-aliased (Мослаштириш) менюсидан текст Катлам чегарасини курсатинг: Sharp 

(Тиник) Crisp (каттик),Strong (кучли), ѐки Smooth (юмшок). Бу текстни соясини куринишларини тубдан 

узгартиради ва тасвирга мосдайди. 



  

 

Рис. 3.1. Редактирланаѐтган матин             Рис. 3.2. Узгартириш ва эффектлар куланилган текст 

Alignment (Выключка) тугмаларидан бирига босинг ва керакли булган текстни ѐзилиш чегарасини 

курсатинг(унгдан, чапдан, уртадан)3.4 рамга каранг.  

 

Рис. 3.4. Текстни текслаш усуллари  

Опциялар панелидан текстни рангини курсатинг. Бундан ташкари текст рангини Swatches (Образцы) 

ва Colors (Цвета) палитраларидан хам белгилаш мумкин.  

4.Экрандаги ойнада текстни киритинг.  

5.Янги текст катламини яратиш учун Enter тугмасини босинг агар сизга бошка катлам керак булмаса 

Esc тугмасини босинг.  

Маслахат: Агар  сиз текстлар Билан ишлаѐтганда компютер осилиб колаверса ѐки тезлиги 

кичиклашса унда очилган колган керак булмаган ширифт ойналарини ѐпинг шунда программа тезлиги 

уз холига келади.  

Маслахат: хар сафар текс ѐзишда Янг катламдан фойдалаганингиз макул ва хатоликка эга булган 

катламларни учириб ташланг  

Текстни тахрирлаш. Текстга узгартиришдан олдин уни активлаштиринг ва матиндаги Суз жумла ва 

харифни белгилаб узгартириш киритинг, шунингдек текстни белгилаш учун текст рамкасини устига 

босиш кифоя.  

Текстни масштаблаш(Масштабирование текста)  

Horizontal Scale (Масштаб по горизонтали) и Vertical Scale (Масштаб по вертикали) буйркуларидан 

текстни жойлашиш шаклини узгартириш учун фойдаланинг. Бир хил тугри куринишдаги масштаблаш 

учун куйдаги аммаларга риоя килинг:  



 

Рис. 3.5. Мастабни киритиш                 Рис. 3.6. Текст масшбабини узгартиришдан кейнги холат 

Текст учун махсус эффектлар(Специальные эффекты для текста) 

Энг аввало куйдагиларни эслаб колинг . агар сиз текстни рамкасини масштабини хажмини ва 

тузилишини узгартириш учун уни тахрирланадиган куринишда бажаришингиз керак ва сунгра текстга 

махсус эффектлар кушиш учун ури расм сифатига келтириб сунгар эффектларни кулашингиз мумкин. 

V тугмаси оркали ишга тушурилувчи Move (Силжитиш) асбоби оркали текстни трасформация килиш 

мумкин.  

Show Bounding Box (Показать габаритную рамку) асбобига байрокчани урнатинг Layers (Слои) 

асбоби оркали керакли катламни белгиланг. Экранда текст катлами акс этади. 

 Якка холда киритилган жумла ва сузларни куйдагича узгартириш мумкин:  

 Layers (Катлам) ойтасига жумлани киритинг ва Edit (Правка) менюсидан Free Transform 

(Произвольная трансформация) буйругини танланг;  

 Сичконча Билан текст ойтасини керакли шаклни олгунча суриб боринг бу вазифани бошка асбоблар 

ѐрдамида хам бажариш мумкин.  

Матинни тавсир ва матин оркасида жойлаштириш(Отображение текста позади слоя с рисунком)  

1.Текстли катламни яратинг.  

2.Шу текст катламидан нусха олинг ва уни саклаб куйинг.  

3.Текст нусхасини белгиланиг ва Layer > Type > Convert to Shape (Слой > Текст > Преобразовать в 

фигуру) командасини танланг. Текст катлами автоматик расмга айланади ва уни тахрирлаш энди 

мумкин эмас.  

4.Layer > Change Layer Content > Levels (Слои > Изменить содержимое слоя > Уровни) командасини 

танланг 3.7 расмга каранг. Ёзимган Катлам сиз бошка катламни киритмагунизча нусхалаш омборида 



колади ва актив булиб туради.  

 

                            Рис. 3.7.                                                                     Рис. 3.8. 

5.Ёзилган текст бошка тасвирлар Билан хамоханглигини жигаранг тусга эга булган пиктограмма Input 

(Ввод ) устига босинг ва текст рангини очартиринг ѐки тукартиринг   

6.ОК тугмасини босинг (3.8 расм). Экранинг фоннидан бир кисмига босинг.  

Куринмайдиган матинлар яратиш(Создание исчезающего текста)  

1.Текст киритинг ва уни катламини актив холатда колдиринг.  

2.Layers (катлам) ойнасининг пстки кисмидан Add a mask (Добавить маску) тугмасини босинг. 

Белгиланган жой ѐнида кичик белги(маска) пайдо булади.  

3.G клавишасини ѐки Shift+G тугмалар комбинациясини босган холда Gradient (Градиент) 

асбобини ишга туширинг. 

4.Gradient асбоби ѐнидаги стрелкани босин ва керакли рангни танланг. Linear gradient (Линейный 

градиент) тугмасига босинг ва Normal (Нормальный) режимини танланг шаффофсизлик кийматини 

Беринг(1%дан100%гача).  

5.Текстни устига керакли булган худудни рамка сифатида сизконча Билан белгилан ваш у кисмлар 

очаради ѐки тукаради 3.9 рамсга каранг.  

 

      Рис. 3. 9. Куринмайдиган текст                         Рис. 3.10. Катламга турли эффэктларни                  

                                                                                                             куланиши  

Маслахат.  Текстни эффект Билан кучириш учун у жойлашган катламни активлаштиринг ва  Move 

(Перемещение) асбобини ишга туширинг.  

Маслахат. Агар сиз эффектни узгартирмокчи булсангиз текст жойлашган Катлам устига босинг 

шунда Layer Style  мулокот ойнаси пайдо булади ундан бошка эффэктларни танлашингиз мумкин.  

Текст катламини чегараларини ураш(Обводка текстового слоя)  

1.Blending Options (Опции смешивания) пайдо булувчи ойнасидан Layers (Слои) буйругини танланг.  

2.Style (Стиль слоя) ойнасининг чап тарафида жойлашган Stroke (Обводка) буйруги устига босинг ва  

Preview (Предварительный просмотр) асбобига байрок урнатилганлигини текширинг. У ердан куйдаги 

булимларни куриб чикинг ва керакли улчамларни Беринг: Structure (Структура) Size (Улчам), Position 

(Жойлашиш холати) (улар ташкридан ва ичкаридан булиши мумкин Outside (Снаружи), Inside (Внутри) 

ѐки Center (марказдан)), Blend Mode (Режим смешивания), Opacity (Шаффофсизлик), Fill Type (буяш 

усули) и Color (ранг)  3.11 расмга каранг.  

3.ОК  тугмасини босинг (ѐки Enter тугмасини босинг).  



 

Рис. 3.11.  Текстга Stroke эффэктини Gradient буѐги Билан куланилиши 

Синов саволлари: 

1.Программада текст контурини узгартириш учун кайси буйруклардан фойдаланилади. 

2. Кайси асбоб ѐрдамида Photoshop программасида матинларни яратиш мумкин. 

3.Gradient (Градиент) асбоби кайси тугмалар ѐрдамида ишга туширилади. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4-амалий машгулот 
Фильтр билан ишлаш(Работа с фильтрами) 

 

Ишнинг максади: Филтрларни кулланилиши билан танишиш. 

Photoshop программасида текс ва тасвирларга уларни тиниклигидан то хирилаштиришгача саноксиз 

эффектлар куллаш мумкин( 4.1 расм).  Филтирлар куйдагилардан иборат Blur (Размытие) ѐки Sharpen 

(Резкость) умуман куринмайдиган хира тасвирлар учун; Color Halftone (Цветной растр), Find Edges 

(Выделение краев), Emboss (Рельеф) ѐки Wind (Ветер) –янада Еркин эфектлар учун ; Artistic 

(Художественный), Brush Strokes (Мазки кисти), Sketch (Эскиз) ѐки Texture (Текстура) – тасвир 

яратиш учун; Lighting Effects (Эффекты освещения) – тасвирни ѐритиш учун..  

Filter (Фильтр) менюсида хама филтрлар 13 турга булинган18.2 расмга каранг. Бошк эффектлар эса 

асбоблар омборида сакланади сизга Photoshop программасининг (Help) ойнаси ѐрдамида бу филтрлар 



имкониятлари Билан танишиб чикишингизни маслахат берамиз. 

 

            Рис. 4.1. Groucho филтри                                                  Рис. 4.2. 

Филтрлар хакида асосий малумотлар(Основные сведения о фильтрах)  

Филтрларни куллаш(Применение фильтров) 

Фильтрни катламга ѐки белгиланган Катлам кисмига куллаш мумкин. Филтрни куллашдан олдин 

катламни эффекти куриниб ажралиб колмаслиги учун уни мослаштириш керак.  

Бир хил филтирларни тугридан тугри автоматик тврзда кулаш мумкун. Бошка филтрлани мулокат 

ойнасида унинг улчамларини берган холда бажариш мумкин.  Filter > Last Filter (Фильтр > Последний 

фильтр) (клавишалар комбинацияси Ctrl+F) менюси  буйругини танлаган холда охирги бажарилган 

эффктни бошка катламларга хам куллаш мумкин.  Охирги куланилган эффект мулокат ойнасини очиш 

учун Ctrl+Alt+F тугмалани биргаликда босинг.  

RGB ва Multichannel форматлари рижимижа барча филтрлар мавжуд CMYK, Grayscale ва Lab Color – 

рижимларида эса факатгини бир нечталари мавжуд. Bitmap и Indexed Color рижимларида 16 бит 

каналарига эга булган тасвилар учун филтрларни куллаш мумкин. 

 

Рис. 4.3. Filter менюси 

Филтрнинг мулокат ойнаси(Диалоговое окно фильтра)  

Купгина филтр мулокат ойналари узининг олдиндин куринишини курсатувчи ойнаси мавжуд (4.2. 

расм).  

Мулокат ойнасининг олдиндан куриш ойнаси ичига курсорни олиб боринг ва керакли булган экран 

кисмини белгиланг ва бу кисм ката улчамларда кандай куринишда булишини куришингиз мумкин  ( 

Preview (Олдиндан куриш) булимига байрокчани урнатинг, эффектни кулашдан олдин уни кандай 

куринишга эга булишини олдиндан куриш маслахат берилади).  



Ойнадаги  «плюс» тугмаси устига тасвини каталаштириш учун ва «минус» тугмасига 

кичиклаштириш учун босинг( 4.2 расм).  

Маслахат. Курилаѐтган тасвирни ѐркинлаштириш ѐки хиралаштириш учун клавиатурада жойлашган 

Теппага ва Пастга стрелка тугмаларини босинг.  

Маслахат. Бир тавсирни узига бир нечта филтирларни кулаб куринг ва мулокат ойнасидан 

улчамларни бир бирига мос равишда узгартиринг агар шу эффктларни кенчалик кулаш ихтиѐжи булса 

уларни саклаб куйинг.  

Филтр куланилаѐтган жойни улчамларини чеклаш(Ограничение области, к которой применяется 

фильтр)  

Филтрланган ва филтирланмаган катламлар орасидаги фаркни камайтириш учун филтр 

кулашишидан олдин катламни мослаштиринг  

Шунингдек фолтир имкониятини чеклаш учун каслам никобини(маску) активлаштиринг. Никоблар 

орасидаги ок ва кора чегара кисмлар каттик ѐки юмшок буялиши мумкин бу чегара чизилган муйкалам 

турига боглик. Layer > Add Layer Mask > Reveal Selection (Слои > Добавить маску слоя > Показать 

выделенную область) менюсидаги буйрукни танлаш оркали маска чегарасини эффектланишини куриш 

мумкун ва яна ( Brush Strokes > Spatter (Мазки кисти > Разбрызгивание менюсидаги буйрукни ишлатиб 

куринг), Pixelate > Pointillize (Объединение пикселов > Пуантилизм), Stylize > Wind (Стилизация > 

Ветер) Distort > Zigzag (Деформация > Зигзаг) или Distort > Ripple (Деформация > Рябь)) 

эффектларини хам бажариб куриш мумкун.  

Ёркинлик ва хиралик курсаткичларини узгартириш оркали эффектни янада аник куриш мумкин. 

Бунинг учун Image > Adjustments > Levels (Изображение > Корректировки > Уровни) менюси 

буйругини танланг. 

Агар эффектлардан сунг бир хил ранглар куринмай колса унда Image > Adjustments > 

Hue/Saturation (Изображение > Корректировки > Тон/Насыщенность) менюсидан буйрукни танланг ва  

Colorize (Тонировать) булимига байрокчани урнатинг.  

Эффектлар танлашдан олдин асасий фон ѐки рангига асосланган эффектлар кулаш учун Foreground 

color (Основной цвет) параметрларини аниклаштиринг. 

Филтрлар Билан бир канча машклар(Несколько упражнений с фильтрами)  

 Ripple (Рябь), Twirl (Скручивание) ѐки Zigzag (Зигзаг) филтрлари катламларни букланган, 

гижимланган когоз тасвири куринищидаги холатга келтириш учун куланилади.  

Гижимланган бурчакли тасвир хосил килиш(Создание изображения со «смятыми» краями)  

1.Фон ранги сифатида ок рангни танланг.  

2.Image (Изображение) менюсидан Canvas Size (Размер холста) командасини танланг ва узгартириш 

учун мавжуд булган бир расмни танланг.  

3.М тугмасини ѐки Shift+M тугмаларини комбинациясини биргаликда босиб Rectangular Marquee 

(Прямоугольная область) асбобини ишга туширинг.  

4.Опциялар панелидаги Feather (Растушевка) булимига 8 ракамини киритинг.   

5.узгаришсиз колиши керак булган худудни штрих чегара Билан белгиланг.  

6.Select (Выделение) менюсидан Inverse (Инвертировать) командасини танланг (Ctrl+Shift+I 

клавишлар комбинацияси). Энди узгартириш керак булган худудларни белгиланг.  



7. Filter > Distort > Ripple (Фильтр > Деформация > Рябь) менюсидан командани белгиланг (4.4. 

расм),  Filter > Brush Strokes > Spatter (Фильтр > Мазки кисти > Разбрызгивание) менюсидан 

командани хам бажаринг ѐки мулокат ойнасидан олдиндан куринишни тасвирнинг барча чегараларини 

кузатган холда бажариб куринг.  

Рис. 4.4.                                                                Рис. 4.5.  

Акварел филтр(Акварельный фильтр)  

Расмларни акварел филтри ни ишлатишда  Other (Другие) менюости Minimum (Минимум) 

командасидан ва Noise (Шум) менюости Median (Медиана) командалари оркали амалга ошириш 

мумкин.  Уларни эффектни Watercolor (Акварель) филтири эффекти Билан солиштириб куринг.  Бир 

тасвирга куланган бир неча эффектларни акс этирган маслахат ойнасига босинг.  

    

  Рис. 4.6. Мавжуд расм                                                    Рис. 4.7. Хосил булган тасвир  

1.Акварел филтрини куламокчи булган канламдан нусха олиб уни саклаб куйинг.  

2.Тасвир ни белгилаб Filter > Noise > Median (Фильтр > Шум > Медиана) менюсидан командани 

белгиланг.  

3.Radius (Радиус) булимидан 2 ва 8 курсаткичлари оралигида улчамни суриб куринг   

4.ОК тугмасини босинг  

5.Filter > Others > Minimum (Фильтр > Другие > Минимум) куйдаги командани бажаринг.  

6.Radius (Радиус) курсаткичини 1, 2 ѐки 3 оралигига жойлаштиринг   

7.ОК тугмасига босинг (4.6-4.7 расмлар).  



8.Хохишга кураFilter > Sharpen > Sharpen More(Фильтр > Резкость > Резкость плюс) менюсининг 

командасини бажариб куринг.  

Харакат сохта куринишини хосил килиш(Создание иллюзии движения)  

Тасвирни сохта харакат куринишини хосил килиш учун энг аввало кузгалмайдиган тасвирни 

белгилаб ундан нусха олинг сунгра тасвирга Motion Blur (Размытие в движении) филтирини кулланг.  

1. Тасвирни кимиламай турадиган кисмини белгиланг.  

2. Ctrl+Alt+D тугмалари кобинациясини босган холда Select (Выделение) менюсидан Feather 

(Растушевка) командасини танланг.  

3. Белгиланган кузгалмас кисимни Янги катламга кучириш учун Ctrl+J тугмалари 

комбинацияларини босинг. 

4. Сунгра Feather Radius (Радиус растушевки) булимига 5 ракмини киритинг ва ОК тугмасини 

босинг. Бошидаги тасвир катламини белгиланг.  

5. Filter > Blur > Motion Blur (Фильтр> Размытие > Размытие в движении) менюсидан командани 

танланг.  

6. Angle (Угол) булимига огиш бурчагини киритинг( -360° дан 360° гача). Бу ерга биз -17° кийматини 

киритдик.  

7. Тасвирни суркланиш(размытия) курсатгичини Distance (Расстояние) булимида киритинг у 1 дан 

999 гача булиши мумкин. (Биз 50 ракамини киритдик)  

8.ОК тугмасини босинг(4.8 расм).  

 

Рис. 4.8. Натижавий тасвир  

 

 

 

 

 



 

 

 

 

 

5-амалий машгулот 

Катламлар билан ишлаш. 

Ишнинг максади: Photoshop программасида катламлар Билан ишлашни урганиш. 

Вазифа: 

1. Катламлархакида тушунча ва Янги катлам яратиш. 

2. Хосил килинган катлам устида бир нечта аммалар бажариш. 

3. Хосил килинган хама катламларни учириб ташлаш.  

Назарий кисим. 

Катламлар худи ойна катламларига ухшагандир факат тасвир булган жойларигина куринишга 

эгадир. Хар бир катлам учун узининг шффофлик даражаси булиб уни ундан олдинги ва кенги турган 

катламлар билан хамоханглигини мослаш мумкин.  Катламларни жойлашиш урнини алмаштириш ѐки 

уларни ягона катламга бирлаштириш мумкин. Бир вактни узида хар хил катламларда турган тасвирни 

биргаликда узгартириш ва бир катламда турган расмни факат бир кисмини узгартириш мумкин эмас.  

Layers (Слои) ойнасида катламлар устида турган катламдан энг тагидаги катламгача акс этирилган. 

Бунда фон канлами охирида жойлашади(5.1расм). Хозирда белгиланган Катлам актив булиб куринади 

ва факат шу Катлам утида амаллар бажариш мумкин.  

Исталган катламни активлаштириш учун тартибланиш ойнасидан уни устига босиш керак актив 

булган Катлам номи программа номи ѐнида аксланиб туради.  

 

Рис. 5.1. Layers палитраси 

Эслатма : Ката хажимдаги тасвирлар билан ишлаѐтганда бажарилиб булган катламларни 

бирлаштирган ѐки учириб ташлаш макул шунда программа ишлаш тезлик унимдорлиги ошади ва 

тасвир хажми камаяди.   

Янги катлам хосил килиш(Создание нового слоя)  



1.Энг аввало 100% шаффоф Катлам хосил килиш учун Create New Layer  тугмаси устига босинг.  

2.Агар катламни улчамларини узингиз бериокчи булсангиз унда Alt, тугмасини босиб турган холда 

Create New Layer тугмасини босинг ва кудагича йул тутинг:  

3. Name (Имя) булимида катламни номини киритинг  Group With Previous Layer (Сгруппировать с 

предыдущим слоем) булимига байрокчани урнатинг. 

4.Layers (Слои) палитрасидан куз ва мукйлам куринишидаги пиктограммаларга байрокчани 

урнатинг.  

Mode (Режим смешивания) ва Opacity (Непрозрачность) параметрларидан тасвир учун Янги 

параметрларини берин(кейнчалик бу параметрлар узгартирилиши мумкин).   

5.ОК тугмасини босинг. Янги катлам ишлатилаѐтган катлаи устида пайдо булади.  

Эслатма: Тасвир хажмини камайтириш учун Layers (Слои) менюсидан Palette Options (Опции 

палитры) буйругини танланг ваш у тасвирга тугри келадиган энг кичик хажмни танланг.   

Белгиланган кисмни катламга айлантириш(Превращение выделенной области в слой) 

1.Белгиланган кисмни хосил килинг.  

2.Layer > New > Layer Via Сору (Слой > Новый > Посредством копирования) менюсидан 

командани бажаринг(Ctrl+J тугмалари).  

3.тасвирни белгиланган кисмини юлиб олиб ташлаш учун Layer > New > Layer Via Cut (Слой 

>Новый > Посредством вырезания) командасини бажаринг(Ctrl+ Shift+J тугмалари).  

 

 

Рис. 5.2.  Layer 1 хиралаштирилган фондан хосил килинган тасвир 

 

Катламни силжитиш(Перемещение слоя)  

1. Layers (Слои) ойнасида узгартириш киритмокчи булган катламни белгиланг.  

2. Move (Перемещение) асбобини активлаштиринг(V клавишаси).  

3.Катламни курсорни ушлабтурган холатда катламни силжитинг(5.3 ва 5.4расм).  



 

 Рис. 5.3 . Амалдаги тасвир                       Рис. 5.4. Матнли катламни Move асбоби ѐрдамида      

                                                                                       сититилиши     

Примечание :  Auto Select Layer (Автовыделение слоя) мулимида байрокча турган булса Move 

(Перемещение) асбоби ѐрдамида тезда катламни силжитиш мумкин, аммо бу сижитиш шаффофлиги 

50% дан кам булган булган катламлар чун ишламайди.   

Катламлар билан ишлаш учун асбоблар(Инструменты для работы со слоями)  

Барча асбоблар катламлар Билан шилайди лекин бу Билан катламнинг шаффофсизлигига ката тасир 

утказади шунинг учун Катлам шаффофсизлигини димо назорат килиб туринг.  

Катламни учириш(Удаление слоя из набора)  

Катламни учиришдан олдин уни номини активлигини текширинг, ва уни белгилаб учириб тишланг.  

Катламга эффектлат куллаш(Применение эффектов слоя)  

Катламга куйдаги махсус эффектларни кулаш мумкин: Drop Shadow (Отбросить тень), Inner 

Shadow (Внутренняя тень), Outer Glow (Внешнее свечение), Inner Glow (Внутреннее свечение), Bevel 

and Emboss (Скос и рельеф), Satin (Атлас), Color Overlay (Наложение цвета), Gradient Overlay 

(Наложение градиента), Pattern Overlay (Наложение узора) ва Stroke (Кайма). Эффектларни исталган 

пайтда исталганча исталган катламга куллаш мумкин лекин катламни шаффофсизлигини текшириб 

туринг.  

Эслатма  : Услуб(стили) ва эффектларни бир бири билан чалкаштириб юборманг. Услуб(Стиль) – бу 

бир канча Катлам эффектларини хамоханглигидир.  

Эффектлар Layer Style (Стиль слоя) мулокат ойнаси оркали амалга оширилади.  

Эффект ѐнидаги галочка бу эффектк шу катламга куланилганини курсатади. Катлам эффектларини 

асосий фон учун кулаш мумкун эмас.   

Хама катламларни биргаликда ишлатиш(Задействование всех слоев)  

Агар опциялар панелида куйдаги асбоблар ишлатилаѐтган булса: Blur (Размытие), Sharpen 

(Резкость), Smudge (Палец), Paint Bucket (Ведро с краской), Magic Eraser (Волшебный ластик) или 

Magic Wand (Волшебная палочка) унда Use All Layers (Использовать все слои) булимига байрокчани 

урнатинг шунда ранг ва бошка улчамлар олинаѐтганда мавжуд булган рангларга якин булган туслар 

биринчи навбатта куринади. Факат актив булган катламда ранглар узгаради 

Икки катламни бирлаштириш(Слияние двух слоев)  



1.Бирлаштирмокчи булган икки катламдан кайси бириси олдинро бклса уни белгиланг.  

2. Layers (Слои) менюсидан Merge Down (Слить с нижним) командасини белгиланг ѐки  Ctrl+E  

тугмаларини биргаликда босинг . Актив Катлам узидан пастда турган Катлам Билан бирлашади. Бир 

канча белгиланган катламларни бирлаштириш учун  Merge Layer Set (Слить набор.слоев)командасини 

танланг.  

Катламларни бирлаштириш(Объединение слоев) 

Диккат : Flatten Image (Плоское изображение) командаси катламларни пастдан бошлад 

бирлаштиради ва яширилган катламларни автоматик тарзда учиради.  

Хама катламлар куриниб турганлигига амин булинг ва кайси катлам актив булиши мухим эмас. 

Layers (Слои) менюсидан Flatten Image (Плоское изображение) командасини танланг. Агар 

программада бекитилган катламлар булса унда огохлантириш берилади ва ОК тугмасини босинг ва 

бирлаштиришни давом этиринг. Агарда пастки катламларда куринмайдиган нукталар булса улар ок 

ранга киради.   

Катламни учириш(Удаление слоя)  

Layers (Слои) менюсидан кераксиз Катлам номини танланг. Сунгра Trash (Корзина) тугмасини 

босинг ва Yes (Да) тугмасини хам босинг.  

Катламни учиришни Яна бир усули кераксиз Катлам номи устига олиб бориб сичконсани унг 

тугмасини босинг ва менюдан Delete Layer (Удалить слой) булимини танланг хамда  Yes тугмасини 

босинг.  

                                                             Синов саволлари: 

1. кандай усулда катламлар хосил килинади? 

2. Катламларга кандай эффектлар кулаш мумкин? 

3. Ажратилган кисимда янги катламни хосил килишни курсатиб беринг.        

 

 

 

 

 

 

 

 

6- амалий машђ улот 

 

 

СОRЕL DRAW  дастурида хужжатларни яратиш ва очиш.  

 

Ишдан максад: СОRЕL DRAW  дастури билан танишиш. 

 

Топшириклар: 



1. Назарий кисм билан танишинг. 

2. СОRЕL DRAW   дастури ѐрдамида янги хужжат очишни урганинг. 

3. СОRЕL DRAW   тафсияномалари билан танишинг. 

 

Назарий кием. 

 

Юклангандан сунг дастур экранга «Хуш келибсиз СОRЕL DRAW»  мулокот ойнасини 

чикаради ва бир нечта вариантларни такдим килади: янги хужжат яратиш (GRAPHIC), охирги 

яратилган хужжатни очиш (Ореп last edited), мавжуд хужжатни очиш (Ореп GRAPHIC), укитиш 

тизими (СОRЕL TUROR). 

Янги хужжатни яратиш учун файл (FILE) менюсида Янги (NEW) командасини бажарилади. 

Мавжуд хужжатни очиш учун файл менюсида очиш (Ореn) командаси бажарилади. 

СОRЕL DRAW   дастури бир неча хужжатларни бир вактда очиш 

имкониятига эга, у холда шу пайтда керак булмаган хужжатларни ѐпиш 

кузда тутилган. Меню Файл (FILE) булимида ѐпинг (Закрыть, Сlose) 

командаси бажарилганда актив хужжат ѐпилади. Дастур юклангандлан сунг 

экранда пайдо дастур ойнасига фойдаланувчининг интерфейси 

дейилади(User1Тзег т1егтазе). Интерфейс инсон ва компьютер орасида богловчи 

булиб ишлаш учун панель, асбоблар, мул окот ойнаси ва х.к ларни таклиф 

этади. Фойдаланувчи интерфейсига сахифа, бош меню, хужжатларни акс 

эттирувчи ишчи ойналари хамда тасвирларни мухаррирлигини амалга 

оширувчи хар хил панеллар туплами. Ойнанинг марказидаги ката ок майдон 

ишчи ишчи худуд булиб хар бир хужжат алохида - алохида очилади. 

Экраннинг тепа кисмида бош меню булимлари куйидагича номланади: 

• Файл (File) 

• Мухаррир (Редактирование, Edit) 

• Куриниш (Просмотр, View) 

• Кампановка (Layout) 

• Бошкарув (Управления,    Аrrange) 

• Эффектлар(Еffects) 

• Нуктавий тасвир  (Точ.изоб, Вitmaps) 

• Матн (Техт) 

• Сервис (Тооls) 

• Ойна (Окно,Windows) 

• Ёрдам (Помощь, Не1р) 

 

 

Бу командаларнинг хар бири функционал жихатдан якинбулган амалларни бажаради, 

масалан: матн менюси матн билан ишлайдиган командалардан иборат, эффект менюси нуктавий ва 

векторли графикани яратадиган командалар тупламидан иборат. 

Хоссалар асбоблар катори ( Ргореггу Ваr) 

Хоссалар асбоблар каторидаги ( Ргореггу Ваr) майдонлар ва тугмалар туплами 

,ишлатилаѐтган асбоб ѐки белгиланган объект турига боглик холда 

 
 

куринишга эга булади, масалан, матн блокка олинганда хоссалар каторида матн параметрлари акс 

этади. СОRЕL DRAW  Oбъектлар белгиланмаган холатда хоссалар каторида (Ргореггу Ваr) 

хужжатнинг умумий параметрлари берилади, масалан: варакнинг формати, жойлашуви ва бошкалар. 

Холат катори   (Status  Ваr) 

Ишчи экраннинг пастки кисмида холат катори (Status  Ваr) жойлашган бўлиб турли хил  

 



хизмат маълумотларини акс эттиради: параметрлар, обводка ва ранглар, харф параметрлари 

ажратилган объектлар хакида маълумот ва актив асбоблар хакида маълумот. Бу каторнинг, 

куриниши холати ва таркибини узгартириш мумкин. 

 

Асбоблар панели(Тооlbох) 

Ишчи ойнанинг чап тарафида асбоблар панели жойлашади. Бу панелда барча инструментлар 

жойлашган булиб, улар ѐрдамида турли график объектларни яратиш ажратиш, тахрирлаш мумкин. 

Асбоблар билан ишлаѐтган пайтда белгиланган объектга боглик холда курсорнинг куриниши 

узгаради. Бундан ташкари асбоблар панелида баъзи асбобларни ажратиб олиш мумкин, бунда бу 

группалар «сузувчи» панеллар ѐки Fluoyut куринишдаги панеллар шаклида булади. 

Docker типидаги панеллар мул окот ойналарининг бир куринишидир. Бу панеллар экранда 

доимий жойлашган булиши мумкин булиб, хужжатларнинг ишчи ойналари билан мулокотда булиши 

мумкин. Ойна (Window) менюсида Docker типидаги команда бажарилади ва очилган руйхатдан 

кераклиси танланади. 

• Панель Оbject Маnаgег (Диспетчер объектов) - объект ва 

катламларнинг параметрларини акс эттиради. 

• Панель Virw Маnаgег (Диспетчер видов) - аксларининг 

куринишларини яратиш ва бошкариш учун. 

• Панель Graphic and Техt Styles (Стили текста и графики) - график 

ва матнли обьектларни яратиш ва номланиши учун. 

• Панель Со1оr Styles (Цветовые стили) - ранглар тупламидан 

фойдаланиш учун. 

 

• Панель Symbols and Special Characters (Символы и специальные 

знаки) - декоратив символлар синфи танлаш учун. 

• Панель Internet Bookmark Маnаgег (Диспетчер закладок Internet) - 

матнли гипермурожатларни яратиш ва бошкариш учун. 

• Панель НТМL Оbject Conflict (Анализатор конфликтов объектов 

НТМL) - хужжатларни коррекциялаш ва текшириш, Internet тармоги оркали 

такдим етиш учун. 

• Панель Script and Preset Маnаgег (Диспетчер макросов и готовых 

образцов) - макропрграммаларни ѐзиш ва созлаш учун учун. 

• Панель Оbject  Data (База данных) - хужжатдаги жадвални хар 

бир объектларини маълумотини узлаштириш, масалан: улчами, нархи ва 

бошкалар. 

• Панель Оbject Рrореrties (Свойства объектов) - хужжатдаги 

объектларни параметрларини узгартириш ва акс эттириш учун. 

• Панель Link Маnаgег (Диспетчер связанных изображения) - 

хужжатда булмаган аммо у билан алокада булган тасвирларни бошкариш. 

• Панель Вitmap Со1ог Маsк (Цветовая маска точечного 

изоражения) - нуктавий тасвирларни рангли никобларни яратиш учун. 

• Панель Lens (Линза) - Линза турларини танлаш ва 

параметрларини аниклаш учун. 

• Панель Аrtistic Mеdia (Имитация) - мураккаб куринишдаги 

вектор муйкалами билан ишлаш учун. 

 



 
 

 

•Тгапsformation(Трансформирование)панели хар хил 

куринишдаги трансформацияни бошкариш учун 

• Панель Shaping(Измeнение формы) - бир нечта объектларнинг 

учта куринишини биттага комбинация килиш. 

• Панель Со1ог (Цвет)  и Со1ог Ра1ette  Вгоwser (Цветовые палитры) - ранг билан ишлаш 

учун 

• Панель Вгоwse (Обзор) - дастур хужжатларини куриш ва 

бошкариш учун 

 
 

•   Панеллар Cliparts (Векторные изображения), Рhotos (Фотографии), ЗD models (Трѐхмерные 

модели) - проuрамма Билан бериладиган СD-RОМ компакт дискларини куриш учун 



• Панель FТР Sites (Сайты FТР) - FТР сайтларга мурожатларни 

саклаш учун ва катта массивдаги ахборотлар билан ишлаш учун. 

 

Синов саволлари: 

 

1.    СОRЕL DRAW   дастурида кандай ишлар бажарилади. 

2.   Файл булимига нималар киради. 

3.    Дастур асбоблар панели хакида маълумот беринг. 



7- амалий машђ улот 

 

Дастурнинг объектлари ва уларнинг шакллари билан ишлаш. 

Тугри туртбурчак (Rectangle), Эллипс (Еllipse), Объект гурухлари(ОЬject), спирал                                

асбоби (spiral) , стандарт объект асбоблари билан ишлаш. 

 

 

Ишдан максад: СОRЕL DRAW объектлари билан ишлашни ва тугри туртбурчак, 

эллипс,спирал чизишни урганиш  

 

Топшириклар: 

1. Назарий кисм билан танишинг. 

2. Дастур ѐрдамида тугри туртбурчак чизишни урганинг. 

3. СОRЕL DRAW  дастурида геометрик фигураларни яратишни урганинг 

4.Эллипс,спирал асбобларида ишлашни урганинг. 

 

Назарий кисм 

 

СОRЕL DRAW дастури векторли тасвирларни яратишда турли воситаларни куллайди- 

ингичка чизиклар,патсимон штрихлар.Шунга карамай векторли графиканинг иш 

усули,"кулда" чизишдан анча фарк килади.Шунинг учун векторли контурни яратишни ва 

тахрирлашни тасаввур кила олиш керак. 

Шу максадда СОRЕL DRAW   дастури геометрик фигураларни яратиш (тугри 

туртбурчак, купбурчак, эллипс, спирал) учун мулжалган асбобларга эга,бундан ташкари "эркин 

чизиш" асбоблари (перо, каллиграфик, перо). Градиентли сетка (Меsh Fill),  векторли 

графиканинг асосий инструмента булган Безъе — эгри чизиклари, Безъе асбоби (Веzier). 

Векторли контурларни тулик тахрирлаш кандай асбоблар оркали яратилганлигидан 

каттий назар бир хил усулда бажарилади: Форма (Shаре) асбоби ѐрдамида, редактор махсус 

панели (Node Edit) тармоги оркали ѐки уни алмаштирувчи хоссалар асбоблар катори (Ргорегtу 

Ваr). 

Контурлар ва таянч нукталар 

 

    Контур (раth) бу чизик булиб дастурнинг чизувчи  

асбоблар оркали яратилади ва объектнинг симли структурасини  

ташкил килади.Кейинчалик контур обводка параметрларини (оutine)  

ва рангларини (fill) такдим килиши мумкин ва бунинг натижасида 

 у куринишга эга булиб чоп этилиши мумкин. Агар контурда  

кайсидир параметрлар етишмаѐтган булса у оддий режимда  

куринишга эга булмайди, тулик объект шаклида хужжатда  

саклансада, печатга чикарилмайди. Форма (Shape) асбоби ѐрдамида  

ажратиш мумкин булган - контур (ташкил килувчи контур – 

 комбинацияланувчи контурлар йигиндисидир), алохида объект 

 хисобланади (оЬject). 

Одатда контур куп сегментлардан ташкил топади, бу контурлар  

таянч нукталарида уланган Безъе эгри чизикларидан ташкил 

топган. Сегментнинг бир таянч нуктаси жойини узгартириши 

 шаклни узгартиради. Сегмент шаклини бошкарувчи нукталар 

оркали хам узгартириш мумкин. 

     Стандарт геометрик фигураларни (тугритуртбурчак, элипс, ѐй, айлана) 

яратиш учун мулжалланган асбоблар сичкончанинг бир харакати оркали 

геометрик фигурани чиза олади. 

 

Тугри туртбурчак (Rectangle) 

 

Тугритуртбурчак асбоби исталган тугритуртбурчак ѐки квадратларни чиза олади. 

Тугритуртбурчак чизиш учун асбоб устида сичконча тугмасини босиб куйиб юбормаган холда 



керакли улчам олинади. Агар тугритуртбурчакни марказий нуктадан чизиш лозим булса,<Shift> 

тугмасини босиб туриш керак, квадрат чизиш учун <Сtгl> тугмаси ишлатилади. 

 
 

Ажратилган объектда унг тугма оркали 

контекст менюсини чакириш мумкин, бунда 

экранга объект хоссалари панели чикади. Бу 

панелда тугритуртбурчак асбоби ва четлари 

силликланган бурчаклар майдони булиб бунда 

хар бир бурчакни силликланиши фойизларда 

ифодаланади  

Силликланган бурчакларни  Форма 

ѐки Стрелка асбоблари оркали яратиш 

мумкин.Бунинг учун сичконча курсаткичини 

туртбурчак бурчагига олиб келиб босиб 

турган холда четга тортилади. 

 

 

Эллипс асбоби (Еllipse) 

 

Эллипс асбоби эллипслар ва айланалар чизиш учун мулжалланган.  

Эллипс узига ташки чизилган туртбурчак бурчакларидан бошлаб чизилади.Эллипсни 

чизиш учун марказда <Shift> тугмаси, айлана учун <Сtг1> босилиши лозим.Объект хоссалари 

панели ердамида эллипс параметрларини узгартириш мумкин. Эллипс тугмачасининг юкори 

кисмидаги вкладка оркали эллипснинг типини танлаш мумкин.Эллипс, Сектор, Ёй.Бу 

тугмалар хосалар асбоблар каторида кайтарилади. 

Учта асбоб, купбурчак (Ро1уgon), Спираль (Spiral), Кордината вараг и (Graph Paper), 

объект гурухига йигилган булиб асбоблар панелидан алохида панел куринишида ажратиш 

мумкин. 

 

Спирал асбоби (Spiral) 

 

 Спираллар яратиш учун мулжалланган ѐки узлуксиз эгри чизиклар шаклидаги геометрик 

шакилларини яратиш мумкин. Спирал чизиш жараѐни туртбурчак чизиш жараѐни билан бир хил. 

Спирал асбоблари булимидан семетрик ва логорифмик тугмалар оркали спирал турини танлаш 

мумкин. Мунтазам спирал яратиш учун <Сtг1> тугмасини босиб туриш керак. Спирал 

параметрларини хоссалар асбоблар каторидан узгартириш мумкин. 

 



 

 

Синов саволлари: 

 

1.Дастурда квадрат чизиш учун кайси стандарт тугма босилади. 

2. Тугри туртбурчак асбоби ердамида нималар чизиш мумкин. 

3. Дастурда геометрик фигуралар кандай яратилади. 

4.Контур ва таянч нукталар хакида маълумот беринг. 

5.Дастурда эллипс фигураси кандай яратилади. 

6.Дастурда спирал фигураси кандай яратилади.

 

 

8-амалий машђ улот 

 

Эгри чизиклар гурухи асбоблари (Сurve), Купбурчак асбоби (Ро1уgоn).  

Кордината когозли асбоби (Graph Paper), Чизиш асбоблари (Freehand) билан ишлаш. 

Безъе асбоби билан ишлашни урганиш. 

Ишдан максад:   Кордината когозли асбоби билан параметрли решѐтка яратиш. 

Купбурчак асбоби (Ро1уgоn) билан ишлашни урганиш. Безъе асбоби имкониятлари билан 

танишиш. 
 

Топшириклар: 
1 .Назарий киcм билан танишинг. 

2.Дастурда кордината когозли асбоби (Graph Paper), Чизиш асбоблари (Freehand) билан 

ишланг. 

3. Дастур ердамида кубурчак чизишни урганинг. 

4. Дастурда тугри чизикни яратишни урганинг. 

 

Назарий киcм 

Эгри чизиклар гурухи асбоблари (Сurve) 

 

Эгри чизиклар гурухи асбоблари 

панелида куйидаги ускуналар бор: Чизиш 

(Freehand), Безъе (Вezier), Перо (Natural Pen), 

Чизик улчами (Dimension), Богловчи чизик 

(Соnnector Line) ва Богловчи (Соnnector).  

 

 
 

Купбурчак асбоби (Ро1уgоn). 

 



 

Купбурчакни, керакли томонларга 

эга булган геометрик объект сифатида 

тушуниш мумкин. Купбурчакнинг бир 

варианти сифатида юлдузчани олиш 

мумкин, бунда ички чизилган 

купбурчакни майдонини кесиб утади. 

Купбурчакни ѐки юлдузчани чизиш 

туртбурчак чизишдан фарки йук. С1г1 

тугмасини босиб турган холда мунтазам 

купбурчак чизилади. Купбурчак 

параметрларини объект хоссалари панели 

оркали узгартириш мумкин. 

Купбурчак вкладкасини танлаб 

ушбу панелда томон кирра майдонида 

купбурчакнинг кирралар сонини киритиш 

мумкин. Кирралар уткирлиги майдонида 

шартли бирлик ларда кирранинг уткирлик 

даражасини киритиш мумкин. Купбурчак 

ва юлдузча тугмачалари купбурчакларни 

танлаш имконини беради. Барча ушбу 

майдон ва тугмачалар хоссалар асбоблари 

каторида кайтарилади 

 

 

Шуни айтиб утиш керакки дастурда баъзи келишмовчиликлар хам бор. Масалан, 

параметрлар мулокот ойнасида купбурчакнинг юлдузча шаклидаги яна бир тури мавжуд. (Ро1уgon as 

Star) 

 
 

Координата  когозли асбоби (Graph Paper) 

 

Кордината когозли асбоб берилган 

параметрли решѐтка яратиш имконини 

беради.Бундай решѐткани графиклар ѐки 

диаграммалар учун координатали асос килиб олиш 

мумкин.Бу инструмент параметрларини, 

параметрлар мулокот ойнасида координатали когоз 

булимида узгартириш мумкин. Ячейкалар сони 

майдонида энига (Number of cells wide) буйига 

(Number of cells high) кура ячейкалар микдорини 

узгартириш мумкин.Квадрат ячейкали решѐткаларни 

тайѐрлаш учун <Сtг1> тугмасини босиб туриш керак.  

 

 



 

Чизиш асбоблари (Freehand). 

 

Чизиш асбоблари исталган чизиклрни чизиш 

учун мулжалланган. Бу асбоб иши натижасида 

векторли контур хосил булиб бу контур таянч 

нукталари дастур ѐрдамида автоматик куйилади. Бу 

контурлар устида эркин тахрирлаш имкони мавжуд. 

 

 
 

 

Бу асбобларда чизаѐтган пайтда линиялар калинлиги ва обводкалар рангини 

узгартириш мумкин. Чизиб булинган чизикни исталган пайтда давом эттириш мумкин. 

Бунинг учун курсорни унинг охирги нуктасига олиб келиб (курсорнинг эгри чизиклари 

курсаткичга айланади), сичконча тугмасини босган холда чизикни давом эттириш хамда 

чизиш асбоблари ѐрдамида тугри чизик чизиш мумкин. 

Безъе асбоби ердамида максимал аниклик ва максимал рационаллик билан ихтиерий 

контурни яратиш мумкин. Бу асбоб фойдаланувчини график дизайнда барча нарсани хал 

килувчи Форма яратувчисига айланишига имкон беради. 

Тугри чизикли сигментлар тузиш. 

Тугри чизик яратиш учун Безъе асбоби кулай келади. Бунинг учун Безъе асбобини 

танлаш керак. Курсорни бошдангич нуктага олиб келиш ва сичкончанинг чап тугмасини босиш 

керак. Тугма босилган жойда сегментнинг бошлангич таянч нуктасини ифодаловчи кора нукта 

пайдо булад. У кейинги нукта яратилгунга кадар актв булиб туради . Сунг курсирни кейинги 

нукта жойлашадиган янги жойга олиб утиш керак . Икки нукта Тугри чизик билан туташади. 

Таянч нукталарнинг турлари. 

Бир неча сегментларнинг туташишида таянч нукталари Сorel Draw дастурида уч типли 

булиши мумкин : 

1. Икки эгри чизикни "букилишда" туташтирувчи таянч нуктаси - бурчак таянч нуктаси 

дейилади . (cups node) БундаЙ таянч нуктасида бошкарувчи чизиклар хам йуналиши ,хам узинлиги 

буича мустакилдир. 

2. Икки эгри чизикни синишсиз туташтирувчи таянч нуктаси -силик таянч нуктаси 

деилади (smooth node) Бундай таянч нукталарда бошкарувчи чизиклар бир-биридан факат 

улчами билан гина мустакил, ѐналиши боича эса умумий туташувчи тугри чизикни ташкил 

килади .Бошкарувчи чизикларни бирининг урин алмашиши иккичи хам урин алмашишига 

олиб келади. 

3. Синишсиз ва бир хил киялик билан туташган таянч нуктаси симетрик таянч нуктаси 

деилади (symmetrcal node). Бундай таянч нукталарда бошкарувчи чизиклар бир-бирига хам 

ѐналиши, хам калиги билан боглик 

 

 

Синов саволлари: 
1. Эгри чизиклар гурухи асбоблари панелида кандай ускуналар бор. 

2. Дастурда купбурчаклар кандай яратилади. 

3. Кордината когозли асбоби (Graph Paper)нинг имкониятлари. 

4. Чизиш асбоблари кандай чизиклар чизиш учун мулжалланган. 

5. Таянч нукталари Сorel Draw дастурида неча типли булиши мумкин. 

6. Тугри чизик яратиш учун кандай асбоб кулай келади. 

 

 



 



 

9- амалий машђ улот 

 

Имитация асбоби (Аrtistic Media) Наъмуна режими (Ргеset) билан 

ишлаш.Объектларни пуркаш (Оbject Sprayer) 

 

Ишдан максад: Дастурда объектларни пуркашни урганиш. 

Имитация асбоби ѐрдамида мураккаб тузилишга эга булган безакли шаклларни 

яратиш. 

 

Топшириклар: 

1 .Назарий кисм билан танишинг. 

2. Объектларни пуркаш иши кандай амалга оширилишини урганинг 

3. Дастур ердамида мураккаб тузилишга эга булган безакли шаклларни яратиш. 

 

Назарий киcм 
Имитация асбоби (Аrtistic Media). 

 

Имитация асбоби нуктали графика 

дастурларида купрок ишлатилади. Шунга 

карамай векторли дастур хам бу асбобни такдим 

этади.Бу асбоб оркали Перода чизиш упнини 

боса олади, шу билан бирга безакли штамп 

урнини хам босади. Бу асбобнинг ажойиблиги 

шундаки у асосий контурни чизиб, бу контур 

буйлаб турли обеъктлар жойлашиб манзарали ва 

график эффектларни беради. 

Наъмуна режими (Ргеset) бу режимда 

шундай обеъктларни яратиш мумкинки, бунда 

бу обеъктлар тайѐр наъмуналарга караб уз 

шаклини узгартиради. Бу режимда шакилли 

чизикларни ишлатиш мумкин. 

 

 
Муйкалам режими (Вrush) бу режимда мураккаб тузилишга эга булган безакли шакилларни 

яратиш мумкин. 

Пуркагич режими (Оbject Sprayer) контур тректориялари буйлаб турли график обеъктларни 

жойлаштиради. Бу режим мураккаб рамкалар, безакли каторларни яратиш учун мулжалланган. 

Каллиграфия режими (Саllligraphis) бу режимда калин перо ѐки энли муй калам эгри 

чизикларини чизиш мумкин. 

Босим режими (Ргеssure) бу режимда шундай чизикларни чизиш мумкинки бу чизикларни 

клавиатура оркали бошкариш мумкин. 

 



 
 

  

Наъмуна режими (Ргеset). 

Хоссалар асбоблар каторида бу режим танланса куйидаги параметрларга эга буламиз: 

текислаш майдони (Freehand Smoothing) асосий чизикни 0 дан 100 диапазонигача текислаш 

имконияти.(расмда 1 раками билан курсатидган) 

Улчам майдони (Size)(2 ракам)безакли штрихларнинг улчамини фоизлар хисобида 

узгартиш имконини беради . 1 дан 999% гача. 

Объектлар руйхати майдони (3 ракам) бу руйхатда турли формадаги пуркаладиган 

объектларнинг намуналари келтирилган. 

Save тугмачаси (4 ракам) муйкалам режимида иш юритиш билан бир хил. 

Учириш тугмачаси (Delete) руйхатдаги хохлаган вариантлардан бирини учиради. 

Пуркаш тартиби (Sгау Огdег) (6 ракам) объктнинг контур буйлаб жойлашиш 

руйхатини такдим этади - Тасодафан (Rаmdоm1у), Кетма-кетли (Sеquendally), Юналиш буйлаб 

(Ву Diгекtion). 

Объектлар руйхатига кушиш тугмаси (Аdd to SprayList) (7 ракам ) объектлар руйхатига 

я нги элементларни кушиш имкониятини беради. Улардан кейинчалик "Уйновчи" каторини (play 

list) ташкил килиш мумкин. 

 

Объектларни пуркаш (Оbject Sprayer) ни танланганда хосалар асбоблар каторида 

куйдаги параметларга эга буламиз: 

(Сглаживание) майдони (Freehand Smoothing) (расмда 1 раками билан ) - 0 дан 100 гача 

диапазонда болган асосий штрихни тугирлаш даражасини аниклаш учун мулжалланган. 

Улчамлар майдони (Size) (2 ракам) 1дан 999% гача диапазондаги 

Бошлангич мин. ва мак. улчамларни фоизларда аниклашга имкон беради. Объектлар 

руйхаттида (Spraylist:) (3 ракам) турли хилдаги пуркакланинувчи объектларнинг кенг танлаш 

(дакаративных) намунаси берилган.Save тугмаси (4) минг ишлаш жараѐни мой- калам 

(Вrush) режимида ишлаш жароѐнидан фарк килмайди. Уни СD- R форматида саклаш 

имконини беради. 

Учириш тугмаси (Dеlеtе) (5) руйхатдаги ихтиѐрий вариантни очириш имкониятларни 

беради. 

Пуркаш тартиби руйхати (Sргау Оrder) (6) контур буйлаб объектларни таксимлаш 

усулларининг руихатини - Тасодифий (Ramdomly), кетма кет (sequentially), Йуналиш боича (Ву 

Direktion) Объектлар руйхатига кушиш тугмаси (Add to Spraylist) (7) объектлар руйхатига 

 



янги элемертлар кушиш имкони беради.Улардан кеинчалик «уйнновчи» состав ташкил 

килиниши мумкун. 

бъектлар руихатини активлаш тумаси (Spraylist Dialog) (8) актив элентлар 

руихатини яратиш мулокат оинасини экранга чикаради унда 2 та ойна курсатилган: барча 

объектлар руйхати ойнаси (Spraylist) ва актив объектлар ойнаси (Р1ауlist). 

Объектлар майдони / интервалар (Dabs/Spasing) (9) объектлар ва интерваллар 

сонининг узаро алокасини узгартириш имкони беради. интервалар (Spacing) куйи майдонда 

объектлар мохияти орасидаги интервалларни аниклайди, юкори объектлар (Dabs) 

майдонида эса - хар-бир интервал нуктасидаги шу объектлар сонини. 

Айланиш тугмаси (Rotation) (10) экранга барча объектлар айланишининг параметрини 

узгартириши мумкин булганкушимча ойнани чикаради. 

Жой узгартириш тугмаси (Offset) (11) экранга объектларнинг контурга нисбатан 

кучиш йуналиши ва кийматини узгартириш мумкин булган кушимча ойнани чикаради. 

Кийматни тиклаш тугмаси (Reset Value)(12) мое файлда сакланган бошлангич кийматни 

кайтариши мумкин. 

Каллигрфия режимини танлашимиз билан Свойства (Ргорегtу Ваr) асбоблар панелида 

куйидаги параметрларга йул очилади : 

Текислаш майдони (Freehand Smoothing) (1-ракам билан белгилнган) ва кенглик 

(Width) (2)лар Муйкалм каби функцияланади Бурчак (Angle) (3) майдони муйкаламнинг 

огиш бурчагини аниклаш учун хизмат килади. Свойства асбоблар чизигида Нажим рижими 

танланганда куйидаги параметрларга йул очилади: 

Теккислаш майдони ва кенглик муйкалам штрихи калинлигини бошкариш тугмалар 

ердамида таъминланади. 

 

 

Синов саволлари: 

1. Имитация асбоби (Аrtistic Media)-деганда нимани тушунасиз. 

2. Каллиграфия режими (Саllligraphis)да кандай чизикларни чизиш мумкин. 

3. (Вгush) режиминг вазифасини тушунтиринг. 

4. Объектларни пуркаш нима ? 

5. Spraylist Dialog-тугмачасининг вазифаси. 

6. Айланиш тугмаси (Rotation) нинг вазифаси. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


